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Preface

Welcome to the Essbase Administration Services Installation Guide:

● “Purpose” on page v

● “Audience” on page v

● “Document Structure” on page vi

● “Where to Find Documentation” on page vi

● “Conventions” on page vii

● “Additional Support” on page viii

Purpose
This guide provides you with all the information that you need to install Essbase 
Administration Services and to start it for the first time. It explains the 
Administration Services deployment options, and contains the concepts, 
processes, and procedures that you need to install the software.

Audience
This book is for Essbase system administrators who need to install and configure 
Administration Services software on Windows or UNIX platforms. It also assists 
Essbase system administrators in deciding how to deploy Administration Services 
with Essbase OLAP Servers in an enterprise environment. 
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Document Structure
This document contains the following information: 

Chapter 1, “Overview,” provides an overview of the Administration Services 
architecture and deployment options.

Chapter 2, “Planning the Installation,” lists installation prerequisites and system 
requirements for Administration Services.

Chapter 3, “Upgrading to Release 6.5.1,” describes the process for upgrading from 
Administration Services Preview Release 6.2 to Administration Services Release 
6.5.1.

Chapter 4, “Installing Essbase Administration Services,” describes how to install 
Administration Services.

Chapter 5, “Starting Essbase Administration Services,” provides procedures for 
getting started with Administration Services.

Index contains a list of Administration Services terms and their page references.

Where to Find Documentation
You can access online Administration Services documentation from the following 
locations:

● The HTML Information Map. To open the Information Map launch the 
launcher.htm file located in the eas directory.

Note: On Windows platforms, if you chose to add shortcuts to the Start menu 
during installation, you can also launch the Information Map from the Start menu 
(Start > Programs > Hyperion Solutions > Essbase Administration Services > EAS 
Documentation).

● Most documentation is also accessible from Administration Services Console. 
From the Help menu, select the online document you would like to view or 
click the Help button.

● The Hyperion Solutions Web site is located at http://www.hyperion.com. 
An Essbase-specific Web site is located at http://www.essbase.com .

http://www.hyperion.com
http://www.essbase.com
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➤ To access the documentation from the Hyperion Online Support site:

1. Go to the Hyperion Online Support site at 
http://support.hyperion.com .

2. Enter your User Name and Password, and click Log In. 

If you do not have a User Name and Password, click Register to request one.

3. Under Product Releases, click Software/Documentation.

4. Select the product and the information you want to display, then click Submit.

5. Click the link for the release you are looking for.

6. Click the link of the location nearest you for the file you want to download. If 
you are presented with a dialog box, select the location to which you want to 
save the file and click OK.

Conventions
This book uses several formatting styles to indicate actions that you should take or 
types of information that you need. Table i lists each document convention:

Table i: Document Conventions 

Example Description

Arrows indicate the beginning of a procedure consisting 
of sequential steps.

Bold Bold in procedural steps highlights major interface 
elements.

Ctrl + 0 Keystroke combinations shown with the plus symbol 
(+) indicate that you should press the first key and 
hold it while you press the next key. Do not type 
the + symbol.

Example text Courier font indicates that the material shown is a code 
or syntax example. Names of files and directories also 
appear in this font.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown 
in Courier italics.

http://support.hyperion.com
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Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following support for product information:

● “How to Order Printed Documentation” on page ix

● “Education Services” on page ix

● “Consulting Services” on page ix

● “Technical Support” on page x

● “Essbase.com” on page x

ARBORPATH This environment variable is set to the directory 
path of your Essbase installation. The default is 
C:\Hyperion\Essbase on Windows platforms and 
/home/hyperion/essbase on Solaris platforms. 
When you see the environment variable ARBORPATH 
in italics, substitute the value of ARBORPATH from 
your site.

EAS_HOME The directory where you install Essbase Administration 
Services. By default, Administration Services is 
installed to ARBORPATH. 
When you see EAS_HOME in italics, substitute the 
value of EAS_HOME from your site.

Italics Titles of books and online help systems appear in 
italics. Italics also indicate important terms and special 
emphasis.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format: 
File > New > Folder 

Table i: Document Conventions (Continued)

Example Description
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How to Order Printed Documentation
To order printed documentation: 

● Visit the Hyperion Solutions Web site at http://www.hyperion.com .

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Education Services
Hyperion offers a variety of training options, including instructor-led training, 
custom training, and eTraining. This education covers all Hyperion applications 
and technologies and is geared to administrators, end users, and information 
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s 
diverse, global customers. Hyperion Authorized Training Centers are certified to 
deliver courses developed by Hyperion. Custom Education Services—training on 
the configured and tailored applications that employees use on the job—is another 
option to enhance user productivity and to ensure smooth day-to-day operations. 
A service called eTraining—including computer-based training, Web-based 
training, and interactive Virtual Classroom training—provides a cost-effective 
means of giving users a hands-on introduction to product features and functions. 
Computer-based training (CBT) and Web-based training (WBT) provide 
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager 
or visit the Hyperion Solutions Web site at http://www.hyperion.com to see 
a list of all training classes. 

Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the 
return on investment in, Hyperion products. Experienced Hyperion consultants 
and Hyperion Alliance Partners assist organizations in tailoring solutions to their 
particular requirements, such as reporting, analysis, modeling, and planning. 
Specific services include implementation consulting, custom business solutions, 
data integration, and technical consulting. Additionally, Hyperion offers a variety 
of Services Packages and Reviews.

http://www.hyperion.com
http://www.hyperion.com
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For more information about Consulting Services, Services Packages and Reviews, 
as well as the services offered by Alliance Partners, contact your local consulting 
services representative, or visit the Hyperion Solutions Web site at 
http://www.hyperion.com to see a list of all Hyperion Alliance Partners.

Technical Support
Hyperion provides Web-based and telephone support to ensure that clients resolve 
product issues quickly and accurately. This support is available for all Hyperion 
products at no additional cost to clients with a current maintenance agreement.

● For Web-based support, or to see complete information on 
available support options, visit the Hyperion Solutions Web site 
at http://www.hyperion.com.

● In the United States, call 877-901-4975 for Hyperion Solutions Customer 
Support.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Essbase.com

Essbase.com is your one-stop community destination for all things Hyperion 
Essbase. Visit http://www.essbase.com to accomplish these goals:

● Read the latest news, press releases, and product reviews about Hyperion 
Essbase and learn how companies like yours use Hyperion Essbase everyday 
to solve problems, spot opportunities, and improve business performance

● Join an online discussion forum and communicate with other Hyperion 
Essbase users, developers, professionals, and evaluators

● Find information about product releases such as Hyperion Essbase and 
Analysis Tools, including Hyperion Analyzer, Hyperion Analysis Portal, 
Hyperion Application Builder, and Hyperion Objects

● Download Hyperion Essbase Add-ons/Modules and non-Hyperion supported 
third-party utilities that can be used with Hyperion Essbase

● Access the Support Library which provides a wealth of information to help 
you maximize your Hyperion Essbase implementation

http://www.hyperion.com
http://www.hyperion.com
http://www.essbase.com
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1

Chapter

1
Overview

This chapter introduces you to Essbase Administration Services and explains how 
to deploy this new Essbase administration tool. 

● “About Essbase Administration Services” on page 11

● “Deploying Essbase Administration Services” on page 12

About Essbase Administration Services
Essbase Administration Services is the new cross-platform framework for 
managing and maintaining Essbase. Administration Services provides a single 
point of access for viewing, managing, and maintaining OLAP Servers, 
applications, and databases. This new product incorporates the functionality of 
Essbase Application Manager along with other new administrative features and 
with Essbase administration tools, such as MaxL. 

Administration Services consists of two components:

● Administration Services Console (client tier)

This component is a Java client console that enables administrators to manage 
the Essbase environment from a robust graphical user interface.

● Administration Server (middle tier) 

This component is a Java based web application server that communicates 
with both Administration Services Console and Essbase OLAP Servers. 
Administration Server maintains communication and session information 
for each connection to OLAP Servers. Administration Server also stores 
documentation files so that console users can access the documentation 
without having to install it locally. 
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Administration Server serves as the middle tier between Administration Services 
Console and Essbase OLAP Servers, as shown in Figure 1.

Figure 1: Essbase Administration Services Architecture

These three tiers do not have to be installed on the same computer nor on the 
same platform. For more information, see “Deploying Essbase Administration 
Services.”

Deploying Essbase Administration Services
You can install Administration Services on the same computer as Essbase or on a 
different computer, in various configurations. For example, you can install OLAP 
Server on a computer running UNIX and install Administration Server and 
Administration Services Console on a computer running Windows. You can also 
install Administration Server and Administration Services Console on separate 
computers and platforms. For a list of supported platforms, see “Supported 
Platforms” on page 23. 

Essbase components can be installed in many available deployment scenarios. The 
best configuration depends on your organizational requirements and on which 
release of OLAP Server you are using. Here are a few deployment scenarios to 
consider:

● Administration Server on one computer, OLAP Server on a separate 
computer, Administration Services Console on one or more client computers, 
as shown in Figure 2 
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You can also have multiple Administration Server computers and multiple 
OLAP Server computers and each computer can run on a different OS 
platform. Consider this configuration if you have multiple administrators 
working with large outlines and your Essbase server has limited resources, or 
if you will be administering large outlines during heavy Essbase usage such as 
querying or building cubes.

Figure 2: Multiple Servers, Multiple Clients

Note: The computer hosting Administration Server needs, at a minimum, Essbase 
Runtime Client Release 6.5.1 files to connect to and communicate with OLAP 
Server. For more information, see “Prerequisites” on page 19.



14 ■

Overview

Essbase Administration Services Installation Guide

● Everything on one computer, as shown in Figure 3

Consider this configuration if you have limited resources or if you need to 
administer Essbase from the computer hosting OLAP Server.

Figure 3: Single-Computer Deployment

Note: Do not use this configuration if you are using OLAP Server Release 6.2. 
OLAP Server Release 6.2 cannot be installed on the same computer as 
Administration Server. For more information, see “Prerequisites” on page 19.
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● Servers on one computer, Administration Services Console on one or more 
client computers, as shown in Figure 4

Each computer can run on a different OS platform. Consider this configuration 
if you have limited resources but need to administer Essbase from multiple 
locations.

Figure 4: Single-Server Computer, Multiple Clients

Note: Do not use this configuration if you are using OLAP Server Release 6.2. 
OLAP Server Release 6.2 cannot be installed on the same computer as 
Administration Server. For more information, see “Prerequisites” on page 19.
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2

Chapter 

2
Planning the Installation

This chapter provides an overview of the installation process and specifies 
the hardware, operating system, and software requirements for Essbase 
Administration Services.

● “Installation Overview” on page 17

● “Verifying Product Contents” on page 18

● “Prerequisites” on page 19

● “Verifying Requirements” on page 21

Installation Overview
Use the following process to install Administration Services and to set up users:

1. Install Essbase OLAP Server Release 6.2 or Release 6.5.1. 

See the Hyperion Essbase Installation Guide.

2. Get ready to install Administration Services Release 6.5.1:

● Verify that you have all of the necessary software and documentation. 
See “Verifying Product Contents” on page 18.

● Decide how you want to deploy Administration Services. You can install 
Administration Services on a different computer or platform than Essbase 
OLAP Server. For more information on deployment, see “Deploying 
Essbase Administration Services” on page 12.

● Ensure that you have met the installation prerequisites as described in 
“Prerequisites” on page 19.

● Confirm that your platform is supported by Administration Services and 
that system requirements are met for the computer on which you are 
installing. See “Verifying Requirements” on page 21.
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3. Install Administration Services. 

For more information, see “Installing Essbase Administration Services” on 
page 29.

4. Start Administration Services. 

For more information, see “Starting Administration Services” on page 39.

5. Set up the Administration Services users. 

For more information, see “Setting Up Users” on page 43.

6. Make a backup copy of the database used to store Administration Services 
user information. 

For more information, see “Backing Up User Information” on page 43.

7. Specify an outgoing mail (SMTP) server on the Administration Server 
computer.

For more information, see “Setting Up an SMTP Server” on page 43.

Verifying Product Contents
Before you install Administration Services, confirm that you have all the 
necessary product components:

● The Hyperion Essbase Release 6.5.1 CD or the appropriate self-extracting 
download files from the Hyperion Download Center

● This book, the Essbase Administration Services Installation Guide

● The Essbase Administration Services Installation Checklist

● The Essbase Administration Services Readme File

● The Hyperion Essbase Installation Guide
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Prerequisites
Before installing Administration Services, make sure that you have met the 
following prerequisites so that Administration Services works properly:

● Install Hyperion Essbase Release 6.2 or Release 6.5.1. 

If you plan to use Administration Services to manage Essbase OLAP Server 
Release 6.2, you must install Essbase OLAP Server and Administration 
Server on separate computers.

If you already have OLAP Server Release 6.5 installed, you need to upgrade 
it to Release 6.5.1 before installing Administration Services. To install the 
6.5.1 software, see the Hyperion Essbase Installation Guide.

Note: Administration Services does not support multiple OLAP Servers running 
on different port numbers. All OLAP Servers you connect to through Administration 
Services must be running on the same port. If you have changed the default port 
for an OLAP Server in the essbase.cfg file, you need to change all OLAP Server 
ports to use that port number. You must change the port number in the 
essbase.cfg file on the OLAP Server computer (in ARBORPATH/bin) 
and in the essbase.cfg file on the Administration Server computer (in 
ARBORPATH/bin). If an OLAP Server is installed on the same computer as the 
Administration Server, the essbase.cfg file is the same and only needs to be 
changed once. For more information, see the Essbase Administration Services 
Online Help.

● The computer hosting Administration Server needs, at a minimum, Essbase 
Runtime Client Release 6.5.1 files to connect to and to communicate with 
Essbase OLAP Server. To launch the latest Runtime Client installer, see the 
Hyperion Essbase Installation Guide.

If you have already installed OLAP Server Release 6.5.1 on the computer on 
which you are installing Administration Server, you do not need to install 
Runtime Client.

If you attempt to install Administration Server on a computer that does 
not have, at a minimum, Runtime Client Release 6.5.1 installed, the 
Administration Services installer program reminds you to do so before 
proceeding with installation.
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● Make sure that the ARBORPATH environment variable is set. ARBORPATH 
specifies the root installation directory for Essbase OLAP Server or Runtime 
Client (for example, c:\hyperion\essbase). Because the computer 
hosting Administration Server requires, at a minimum, Release 6.5.1 Runtime 
Client files to work properly, an Essbase installation directory must already 
exist on that computer.

If the ARBORPATH environment variable is not set, the installer program uses 
a default location for installation that you can modify. For information about 
how to set the ARBORPATH variable, see the Hyperion Essbase Installation 
Guide.

● On AIX and HP-UX platforms, make sure that Java Runtime Environment 
version 1.3.1 is installed before you launch the Essbase Administration 
Services installer program. For more information, see “Verifying Your Java 
Runtime Environment Installation” on page 20.

● On UNIX platforms, make sure that XWindows is installed and that there is an 
XWindows session established from the UNIX terminal where users interact 
with Administration Services to the UNIX server where Administration 
Services is executed. For more information, see “Verifying Your XWindows 
Installation” on page 21.

Verifying Your Java Runtime Environment Installation
AIX and HP-UX platforms require that Java Runtime Environment (JRE) version 
1.3.1 is installed before you launch the Essbase Administration Services installer 
program.

➤ To verify if JRE version 1.3.1 is installed, execute java -version.

If JRE 1.3.1 is installed properly, you will see java version "1.3.1". 
Otherwise, ensure that java version 1.3.1 is on the PATH system variable. If 
multiple instances of JRE are installed, version 1.3.1 must be the first JRE 
appearing in the PATH.
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Verifying Your XWindows Installation
All UNIX platforms require that XWindows is installed and that there is an 
XWindows session established from the UNIX terminal where users interact with 
Administration Services to the UNIX server where Administration Services is 
executed.

➤ To ensure an XWindows session is established properly:

1. Run the xterm XWindows terminal application, which is included in the 
standard UNIX XWindows package.

2. If you see the following error message:

"xterm Xt error: Can't open display:"

This means the XWindows session is not established properly. To 
troubleshoot, proceed to the next step.

3. Type echo $DISPLAY.

Ensure the $DISPLAY system variable is set up and points to the UNIX 
terminal display where users interact with Administration Services.

For more information about setting up the XWindows environment, see the 
UNIX system administration guide.

Verifying Requirements
Use the following tables to verify that Administration Services Release 6.5.1 
supports the platforms where you plan to install Administration Services.
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Release Compatibility
Table 1 lists the Essbase OLAP Server releases that work with Administration 
Services Release 6.5.1:

You must install Release 6.5.1 Administration Server with Release 6.5.1 
Administration Services Console. For more release compatibility information, 
see the Essbase Administration Services Online Help.

Note: Administration Services does not support multiple OLAP Servers running on 
different port numbers. All OLAP Servers you connect to through Administration 
Services must be running on the same port. If you have changed the default port for an 
OLAP Server in the essbase.cfg file, you need to change all OLAP Server ports to 
use that port number. You must change the port numbers in the essbase.cfg file on 
the OLAP Server computer (in ARBORPATH/bin) and in the essbase.cfg file on the 
Administration Server computer (in ARBORPATH/bin). If an OLAP Server is installed 
on the same computer as the Administration Server, the essbase.cfg file is the same 
and only needs to be changed once. For more information, see Essbase Administration 
Services Online Help.

Table 1: Supported Essbase OLAP Server Releases

Essbase OLAP Server Deployment Options

Release 6.21

1 Although you can use Administration Services Release 6.5.1 to connect to a Release 6.2 
OLAP Server, you cannot use the features introduced in OLAP Server Release 6.5.x. For 
example, you cannot set the direct/buffered I/O mode at the database level using 
Administration Services 6.5.1 if you are connecting to a 6.2 OLAP Server, because the 
ability to set the I/O mode at the database level first became available with the 6.5 OLAP 
Server.

• Must be installed on a different computer from 
Administration Server

• May be installed on the same computer as 
Administration Services Console

Release 6.5.1 May be installed on the same computer as 
Administration Server or Administration Services 
Console
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Supported Platforms
Table 2 lists the supported platforms for Administration Services Release 6.5.1:

Table 2: Administration Services Supported Platforms 

Platforms Supported Versions

AIX 4.3.3 or later on RS 6000 PowerPC computers

HP-UX 11.0 and lli on PA-RISC computers

Solaris 7 and 8 (SUN OS 5.7 and 5.8) on Sun SPARC or 
ULTRASPARC computers

Windows • Windows XP
• Windows 2000
• Windows NT 4.0
• Windows 98 SE
• Windows ME
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Administration Server Requirements
Table 3 lists the system requirements for Administration Server.
 

Table 3: Administration Server System Requirements    

Component Requirement

Essbase Runtime Client 
Release 6.5.1 

Not required if Essbase OLAP Server Release 6.5.1 is 
already installed on the same computer

Disk space 80 MB minimum (includes documentation files and 
Java Runtime Environment Version 1.3.1)

RAM 64 MB minimum
128 MB recommended

Network protocol TCP/IP

Java platform1 

1 During installation, you can choose between installing Java Runtime Environment (JRE) 
or using an existing installation of JRE. If you choose to use an existing installation, make 
sure that you choose a Version 1.3.1 JRE installation. 

Java Runtime Environment Version 1.3.12

2 For UNIX platforms: Make sure that your operating system has the required patches to 
support JRE Version 1.3.1, even if you chose to install JRE 1.3.1 during installation. For 
more information, refer to the vendor support site for your operating system.
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Administration Services Console Requirements
Table 4 lists the system requirements for Administration Services Console.
 

Table 4: Administration Services Console System Requirements    

Component Requirement

Disk space 30 MB minimum (includes Java Runtime Environment 
Version 1.3.1)

RAM 32 MB minimum 
64 MB recommended

Network protocol TCP/IP

Java platform1

1 During installation, you can choose between installing Java Runtime Environment (JRE) 
or using an existing installation of JRE. If you choose to use an existing installation, make 
sure that you choose a Version 1.3.1 JRE installation. 

Java Runtime Environment Version 1.3.12 

2 For UNIX platforms: Make sure that your operating system has the required patches to 
support JRE Version 1.3.1, even if you chose to install JRE 1.3.1 during installation. For 
more information, refer to the vendor support site for your operating system.
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3

Chapter

3
Upgrading to Release 6.5.1

This chapter describes the process for upgrading from Essbase Administration 
Services Preview Release 6.2 to Administration Services Release 6.5.1.

● “Upgrade Overview” on page 27

● “Uninstalling Administration Services Preview Release 6.2” on page 28

Upgrade Overview
Use the following process to upgrade from Administration Services Preview 
Release 6.2 to Administration Services Release 6.5.1:

1. Verify that you have all the necessary Release 6.5.1 software and 
documentation.

For a list of product components, see “Verifying Product Contents” on 
page 18.

2. Decide how you want to deploy Administration Services. 

You can install Administration Services on a different computer or platform 
than Essbase OLAP Server. For deployment options, see “Deploying Essbase 
Administration Services” on page 12.

3. Ensure that you have met the prerequisites as described in “Prerequisites” on 
page 19.

4. Confirm that your platform is supported by Administration Services and that 
system requirements are met for the computer on which you are installing. 

For more information, see “Verifying Requirements” on page 21.

5. Install Administration Services Release 6.5.1. 

For more information, see “Installing Essbase Administration Services” on 
page 29.
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6. Optional: Uninstall Administration Services Preview Release 6.2.

For more information, see “Uninstalling Administration Services Preview 
Release 6.2” on page 28.

7. Specify an outgoing mail (SMTP) server on the Administration Server 
computer.

For more information, see “Setting Up an SMTP Server” on page 43.

Uninstalling Administration Services 
Preview Release 6.2

If you have Administration Services Preview Release 6.2 already installed and you 
would like to uninstall it, we recommend that you uninstall it after installing 
Release 6.5.1. The reason for this sequence is due to the need to migrate the 
existing user database over to the Release 6.5.1 installation. This migration occurs 
automatically during the Release 6.5.1 installation. If you were to uninstall the 
previous release first, you would have to re-create all the users. It is not required, 
however, that you uninstall Release 6.2.

For uninstallation procedures, see “Uninstalling Administration Services” on 
page 38.

CAUTION: To avoid Java Virtual Machine errors, always uninstall 
Administration Services before you uninstall Essbase OLAP Server.
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4

Chapter

4
Installing Essbase 
Administration Services

This chapter provides instructions for installing Administration Services and 
describes what happens during the installation process. It includes the following 
topics:

● “Launching the Installers” on page 29

● “Installing Administration Services Software” on page 31

● “What Happens During Installation” on page 32

● “Running Administration Server as a Windows Service” on page 34

● “Uninstalling Administration Services” on page 38

Before you begin installation, read and follow the instructions outlined in 
Chapter 2, “Planning the Installation.”

Launching the Installers
Before installing Administration Services, decide which software installation 
format you will use. You can install from the Essbase CD, from installable files on 
a network drive, or from files that you have downloaded from the Hyperion 
Download Center.

➤ To launch the Administration Services installer program from the root of the 
Essbase CD:

1. Insert the Essbase CD.

2. Run setup if the installer program does not start automatically.
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3. Select Essbase XTD Administration Services from the menu provided.

Note: For instructions on installing Essbase software, see the Hyperion Essbase 
Installation Guide.

➤ To launch the Administration Services installer program from the eas directory of 
the Essbase CD:

1. Navigate to the eas directory on the CD.

2. Run the installer program for your platform.

➤ To launch the Administration Services installer from a network location:

1. Navigate to the network folder where the installable file resides.

2. Run the applicable Administration Services installer program for your 
platform.

See Table 5 for a list of installer programs by platform.

➤ To launch the Administration Services installer program from the appropriate 
self-extracting download file from the Hyperion Download Center:

1. Log in to the Hyperion Download Center.

2. Select the product from the list provided.

3. Download the Start Here document for instructions on downloading the 
installer program files.

Table 5: Administration Services Installer Programs by Platform

Platform Directory Installer Program

AIX aix eas651_aix.bin

HP-UX hpux eas651_hpux.bin

Solaris solaris eas651_solaris.bin

Windows win32 eas651_nt.exe
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Installing Administration Services Software
Administration Services provides a cross-platform installer program for both 
Windows and UNIX platforms. You can access the installer program from the 
Essbase CD or from the appropriate self-extracting download files at the Hyperion 
Download Center. To make the installer program available to others without the 
Essbase CD, download the program to a network. 

Note: You can leave OLAP Server running while installing Administration Services.

➤ To install Administration Services:

1. Verify that all prerequisites and system requirements are met. For more 
information, see “Planning the Installation” on page 17.

2. Launch the applicable installer program for the Administration Services 
software. See “Launching the Installers” on page 29 for more information.

3. Follow the installation prompts, keeping in mind the following information: 

● You can choose to perform a complete Administration Services 
installation, or you can install Administration Server and Administration 
Services Console components separately.

● You can install Administration Services to any directory. The default 
directory is ARBORPATH. For more information, see “Prerequisites” on 
page 19. 

● Administration Services requires a Java Virtual Machine that supports 
Java Runtime Environment (JRE) Version 1.3.1. You will be prompted to 
either install a Java Virtual Machine specifically for Administration 
Services, or to use an existing installation of a Java Virtual Machine. To 
find an existing installation of a Java Virtual Machine on your system:

– Click Search for Others to perform an automatic search.

– Click Choose Another to perform a manual search.

Note: Choose a Java Virtual Machine that supports Java Runtime 
Environment Version 1.3.1.

● On Windows platforms, you can install Administration Server as a 
Windows service. For more information, see “Running Administration 
Server as a Windows Service” on page 34.
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After the installation has been completed, you can start Administration Services 
and create users. See “Starting Essbase Administration Services” on page 39.

Note: To make the installer program available to others, copy the eas directory from 
the CD to a network. Other users can then launch the appropriate installer file, as 
described previously. 

What Happens During Installation
During installation, the Administration Services installer program performs the 
following operations:

● Creates several new directories and subdirectories on the hard drive:

By default, the installer program installs the Administration Services software 
to ARBORPATH, where ARBORPATH is the directory in which you installed 
Essbase (for example, c:\hyperion\essbase). But since you can install 
Administration Services to any directory, we refer to this directory later as 
EAS_HOME.

For a listing of the Administration Services directories created and an 
explanation of their contents, see Table 6 on page 33.

● Installs Java Runtime Environment (JRE) version 1.3.1, unless you specify an 
existing JRE installation. 

For more information, see “Verifying Requirements” on page 21.

● Installs documentation files to the following location on the computer hosting 
Administration Server:

EAS_HOME\eas\server\tomcat\webapps\root\easdocs

● Adds shortcuts to the Windows Start menu or to the UNIX /home directory 
(optional during installation).

● Installs programs for uninstalling Administration Services in the following 
directories: 

EAS_HOME\Uninstall_eas_console_651\
EAS_HOME\Uninstall_eas_server_651\

Note: The Administration Services installation does not create or modify any 
environment variables on your system.
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Directories Created
Table 6 lists the directory structure that the installer program creates for a 
complete (server and console) installation. All Administration Services software is 
installed, by default, to ARBORPATH.

Note: The directory where you install Administration Services is referred to as the 
EAS_HOME directory.

Documentation Installed
Documentation files are installed to Administration Server so that all console users 
can access documentation from Administration Services Console without needing 
to install it locally.

All documentation components can be launched from the Administration Services 
Information Map.

Table 6: Directories Created During Complete Installation

Directory Structure Description

EAS_HOME\eas\console

bin Executable files for Administration Services Console

lib Java class files

EAS_HOME\eas\java

bin Executable files for Java

lib Java class files

EAS_HOME\eas\server

bin Executable files for Administration Server

dbms Java data store for persistent storage of Administration 
Server user and session information

lib Java class files

tomcat HTTP listener files1 and documentation files

1 Apache Tomcat Server is installed automatically on all platforms. If you are already 
running another J2EE-compliant engine and understand how servlets are deployed, you 
can move the Essbase Administration Services servlet to your own server. Hyperion, 
however, does not support this configuration. 
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➤ To launch the Information Map in a Web browser, navigate to the EAS_HOME\eas 
directory and double-click the launcher.htm file.

Note: On Windows platforms, if you chose to add shortcuts to the Start menu during 
installation, you can also launch the Information Map from the Start menu. Select 
Start > Programs > Hyperion Solutions > Essbase Administration Services > EAS 
Documentation.

Browser Limitations

The Essbase Administration Services Online Help can be viewed in Internet 
Explorer (version 5.0 or later) or Netscape Navigator (version 4.0 or later). Certain 
features of the help system, however, are not supported by Netscape Navigator or 
by earlier versions of Internet Explorer. For best results, view the online help in a 
recent version of Internet Explorer.

On UNIX platforms, if you use Netscape Navigator to view the help system, you 
must open Netscape before you attempt to launch the help system from the Help 
menu in Administration Services Console.  

Running Administration Server as a 
Windows Service

Running Administration Server as a service enables you to start and stop 
Administration Server from the Windows Control Panel. Running Administration 
Server as an automatic service starts Administration Server as a service when you 
start Windows. This section contains the following topics:

● “Installing Administration Server as a Windows Service” on page 35

● “Verifying That Administration Server Is Running as a Windows Service” on 
page 35

● “Stopping the EAS_Server Windows Service” on page 35

● “Restarting the EAS_Server Windows Service” on page 36

● “Resetting the EAS_Server Windows Service” on page 36

● “Removing the EAS_Server Windows Service” on page 37
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Installing Administration Server as a Windows Service

➤ To install Administration Server as a Windows service:

1. Select “Yes” when prompted to install Administration Server as a Windows 
service during the Administration Services installation.

2. After installing Administration Services, reboot the Windows server.

Verifying That Administration Server Is Running as a 
Windows Service

➤ To verify that Administration Server is running as an automatic Windows service 
after you reboot:

1. Select Start > Settings > Control Panel.

2. Open the Services window.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

You will see EAS_Server in the list of services. The Startup (or Startup 
Type) field for EAS_Server should say Automatic, and the Status field will 
say Started.

Note: If the Startup field is blank or if it says Disabled or Manual, see “Resetting 
the EAS_Server Windows Service” on page 36.

Stopping the EAS_Server Windows Service

➤ To stop the EAS_Server Windows service:

1. Select Start > Settings > Control Panel.

2. Open the Services window.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

The Services window is displayed. EAS_Server is listed in the list of services.
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3. Highlight, but do not double-click, EAS_Server.

4. Stop the service.

● On Windows NT, click Stop.

● On Windows 2000, select Action > Stop.

The Service Control message box is displayed briefly then disappears. 
When it is gone, the Status field for EAS_Server is blank.

Restarting the EAS_Server Windows Service
If you stop the EAS_Server Windows service, you can start it again from the 
Services dialog box of the Control Panel.

➤ To restart the EAS_Server Windows service:

1. Select Start > Settings > Control Panel.

2. Open the Services window.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

The Services window is displayed. EAS_Server is listed in the list of services.

3. Highlight, but do not double-click, EAS_Server.

4. Start the EAS_Server Windows service.

● On Windows NT, click Start.

● On Windows 2000, select Action > Start.

The Service Control message box is displayed briefly then disappears when 
the Status field for EAS_Server is Started.

Resetting the EAS_Server Windows Service
When you install Administration Server as a Windows service, it is listed as 
EAS_Server in the list of services. If, however, someone disables it or sets it to 
manual startup, you can reset the EAS_Server to start automatically.
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➤ To reset the EAS_Server to start automatically:

1. Select Start > Settings > Control Panel.

2. Open the Services window.

● On Windows NT, double-click Services.

● On Windows 2000, double-click Administrative Tools, then 
double-click Services.

The Services window is displayed. Find EAS_Server in the list of services.

3. Double-click EAS_Server.

4. Set the service to log on automatically as a system account.

On Windows NT:

a. In the Services dialog box, click Automatic.

b. Under the Log On As section, select System Account.

On Windows 2000:

a. In the EAS_Server Properties dialog box, select Automatic from the 
Startup type drop-down list box.

b. In the Log On tab, select Local System account.

Removing the EAS_Server Windows Service

➤ To remove the Administration Server as a Windows service:

1. Stop the EAS_Server Windows service. 

For more information, see “Stopping the EAS_Server Windows Service” on 
page 35.

2. From a command prompt, navigate to the following directory:

EAS_HOME\eas\server\bin

3. Run the following command:

remove_service.bat

A message is displayed in the command prompt window indicating that the 
service has been removed.
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Uninstalling Administration Services
Administration Services provides seperate uninstaller programs for 
Administration Server and Administration Services Console components on all 
platforms.

CAUTION: To avoid Java Virtual Machine errors, always uninstall 
Administration Services before you uninstall Hyperion Essbase.

➤ To uninstall Administration Services:

1. If you are uninstalling Administration Server and you installed Administration 
Server as a Windows service, remove the EAS_Server Windows service.

For more information, see “Removing the EAS_Server Windows Service” on 
page 37.

2. Launch the uninstaller program for your platform.

Note: If you are uninstalling Administration Services Preview Release 6.2, the 
uninstaller is located in the ARBORPATH\uninstaller_eas directory.

3. Follow the uninstallation prompts.

Note: On Windows platforms, you can also uninstall from the Control Panel 
(Add/Remove Programs).

Table 7: Administration Services Uninstaller Programs by Component

Component Platform Uninstaller Program

Administration 
Services 
Console

UNIX EAS_HOME/Uninstall_eas_console_651/
Uninstall_eas_console

Windows EAS_HOME\Uninstall_eas_console_651\
Uninstall_eas_console.exe

Administration 
Server

UNIX EAS_HOME/Uninstall_eas_server_651/
Uninstall_eas_server

Windows EAS_HOME\Uninstall_eas_server_651\
Uninstall_eas_server.exe



■ 39Essbase Administration Services Installation Guide

5

Chapter

5
Starting Essbase 
Administration Services

This chapter describes how to start and stop Administration Services and provides 
the access information that you will need to connect for the first time.

● “Starting Administration Services” on page 39

● “Specifying Communication Ports” on page 41

● “Setting Up Users” on page 43

● “Backing Up User Information” on page 43

● “Setting Up an SMTP Server” on page 43

● “Shutting Down Administration Services” on page 45

Starting Administration Services
After you install Administration Services and start Essbase OLAP Server, start 
Administration Server and Administration Services Console. The following 
instructions assume that you have the ARBORPATH environment variable set. For 
more information, see “Prerequisites” on page 19.

Note: For troubleshooting information about starting Administration Services, see the 
eas_readme.htm file in the EAS_HOME\eas directory.

For more information about how connections to OLAP Servers are established and how 
ports are established, see the Essbase Administration Services Online Help.
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Starting Administration Server

Note: If Administration Server is installed as a Windows service, you will not be able to 
start it again manually. This is because the default port number is already in use by the 
Windows service. If you try to start Administration Server again manually, you will be 
prompted to substitute an available port number. For more information, see “Specifying 
Communication Ports” on page 41.

➤ To start Administration Server manually, launch one of the following files:

● On Windows platforms, launch

EAS_HOME\eas\server\bin\adminsvr.exe 

Note: If you chose to add shortcuts to the Start menu during installation, you can 
also start Administration Server from the Start menu (Start > Programs > 
Hyperion Solutions > Essbase Administration Services > Administration 
Server).

● On UNIX platforms, launch

EAS_HOME/eas/server/bin/adminsvr 

When Administration Server starts, a Java console window is displayed.

Starting Administration Services Console

➤ To start Administration Services Console:

1. Launch one of the following files:

● On Windows platforms, launch

EAS_HOME\eas\console\bin\admincon.exe 

Note: If you chose to add shortcuts to the Start menu during installation, you 
can also start Administration Services Console from the Start menu (Start > 
Programs > Hyperion Solutions > Essbase Administration Services > 
Administration Console).

● On UNIX platforms, launch

EAS_HOME/eas/console/bin/admincon

When Administration Services Console starts properly, the Essbase 
Administration Services Login dialog box is displayed.
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2. In the Essbase Administration Services Login dialog box perform these 
steps:

a. Enter the Administration Server name. 

This is the name of the computer on which you installed Administration 
Server. 

b. Enter your Administration Server username. 

If you do not have this information, contact the Administration Services 
administrator. If you are connecting for the first time after installation, use 
the default username, admin. 

c. Enter your Administration Server password. 

If you do not have this information, contact the Administration Services 
administrator. If you are connecting for the first time after installation, use 
the default password, password.

The console is displayed with Enterprise View in the left frame and a blank 
workspace in the right frame. If you are starting Administration Services for 
the first time, the User Setup Wizard is displayed. For more information, see 
“Setting Up Users” on page 43.

Specifying Communication Ports
Administration Services provides four configurable communication ports:

● The Essbase Administration Server port listens to commands from 
Administration Services Console. This port is established when 
Administration Server is started and is released when Administration 
Server is shut down. The default port number is 9001.

● The EAS Agent port is used by the Administration Server agent, which 
handles startup and shut down commands for Administration Server. The port 
is established when you launch the Essbase Administration Server agent 
window and remains in use even if you shut down Administration Server; the 
port is released when you close the agent window. The default port number is 
9005.
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● The Tomcat-Apache connector port is used to connect Apache with Tomcat as 
its servlet container. The port is established when Administration Server is 
started and is released when Administration Server is shut down. The default 
port number is 9008.

● The Apache connector port is used to connect Essbase Administration Server 
with the standard Apache Web server. The port is established when 
Administration Server is started and is released when Administration Server 
is shut down. The default port number is 9009.

If a default port is already in use, you need to specify another port value. See 
“Specifying Port Values” on page 42.

Specifying Port Values

➤ To change a default port used by Administration Services:

1. Start Administration Server. 

For more information, see “Starting Administration Server” on page 40.

Note: On Windows platforms, if you are running Administration Server as a 
Windows service, stop the EAS_Server Windows service and start Administration 
Server manually. For more information, see “Stopping the EAS_Server Windows 
Service” on page 35.

2. In the Essbase Administration Server window, select the Configuration tab.

3. In the Port usage area, enter a different value for the appropriate port.

4. Select Actions > Update.

5. Select Server > Exit to close Administration Server.

6. Restart Administration Server. 

For more information, see “Starting Administration Server” on page 40.

You must restart the server for the port settings to take effect.

Note: To restart the EAS_Server Windows service, see “Restarting the 
EAS_Server Windows Service” on page 36.

7. If you have changed the port setting for the Essbase Administration Server 
port, you may also need to specify a port value after the Administration Server 
name (for example, AdminServerName:9002).
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Setting Up Users
Before other users can begin using Administration Services to manage Essbase, 
you need to add users to Administration Server and populate each user’s Enterprise 
View with the appropriate OLAP Servers.

➤ To add users to Administration Server and populate each user’s Enterprise View:

1. From the Administration Services Console window, launch the User Setup 
Wizard by selecting Wizards > User Setup Wizard.

2. In the User Setup Wizard, follow the prompts to set up users for 
Administration Services, keeping in mind the following factors:

● If you connected using the default administrator information, change the 
password for the administrator account.

● If you need help while using the User Setup Wizard, click Help.

Note: Users can also edit their own list of servers using the User Setup Wizard.

Backing Up User Information
After you create your Administration Services users, Hyperion recommends that 
you make a backup copy of the database used to store Administration Services user 
information. Copy the following directories before you begin working with 
Administration Services. You can then revert to the backup directories if you have 
problems.

● EAS_HOME\eas\server\dbms 

● EAS_HOME\eas\storage 

Setting Up an SMTP Server
To enable administrators to e-mail information directly from Administration 
Services Console to other administrators or to Hyperion Technical Support, an 
outgoing mail (SMTP) server must be specified on the Administration Server 
computer. SMTP (Simple Mail Transfer Protocol) is a protocol for sending e-mail 
messages. When an administrator sends e-mail from Administration Services 
Console, the specified SMTP server is used to send the message to the receiver's 
e-mail client. 
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Specify an SMTP server in the Essbase Administration Server window on the 
Configuration tab. If you do not specify an SMTP server, administrators will not 
be able to send e-mail from the console.

➤ To specify an outgoing mail server:

1. Start Administration Server.

For more information, see “Starting Administration Server” on page 40.

Note: On Windows platforms, if you are running Administration Server as a 
Windows service, stop the EAS_Server Windows service and start Administration 
Server manually. For more information, see “Stopping the EAS_Server Windows 
Service” on page 35.

2. In the Essbase Administration Server window, select the Configuration tab.

3. In the E-mail server area, enter the name of the SMTP server.

4. Select Actions > Update.

5. Select Server > Exit to close Administration Server.

6. Restart Administration Server.

For more information, see “Starting Administration Server” on page 40.

You must restart Administration Server for the setting to take effect.

Note: To restart the EAS_Server Windows service, see “Restarting the 
EAS_Server Windows Service” on page 36.

For more information about setting up an SMTP server, see the Administration 
Services Online Help.
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Shutting Down Administration Services

Closing Administration Services Console

➤ To close Administration Services Console, select File > Exit from the console 
menu bar.

You are prompted to save information such as settings and modifications.

Closing Administration Server

➤ To close Administration Server, select Server > Exit from the server menu bar.
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